SoftWired Education Ltd
e: info@softwirededucation.com
w: www.softwirededucation.com

FindMe,

A Google Chrome Search Extension

Reading. Transform.
Change the way you search online

Software Information Manual

Version 1. January 2024

Cross platform compatiblity on Chrome

s ‘/ FindMe a google chrome cross-platform search extension
o 6 Where Discovery Meets Efficiency
Windows Mac




FindMe Information Manual Version 1. January 2024
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Everything begins with research, but what if you struggle to start?

Poor focus and concentration, difficulties
with motivation, high levels of fatigue, pain,
distractibility, feeling overwhelmed or finding
the process daunting — all these difficulties
make it so much harder to begin research
tasks and the more people struggle, the
easier it is to put it to one side.

Active reading is critical and a strategy

that every university endorses, but wading
through pages and pages of text on line can
just feel too much. You can use CTRL + F to
find a key word, but it is only one word at a
time, and when you search for the next word,
you forget the previous one. How can you
find, read, and keep track of all the important
information on the page?

FindMe enables you to search for all your key
words at once: they are colour coded to help

with memory and associations, but you can
change the colours to suit; you can search
by case and word sensitivity; see where key
words are combined, jJump to them in an
instant and even lock in on the key text using
the visor feature.

In short, FindMe helps students to get started
with research, minimises the stress, builds
confidence, increases efficiency, and enables
them to read actively.

Enhance. Reading. Transform.
Learning.
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FindMe Software Overview

A Google Chrome Search Extension

Our multi-term search tool is more than a
gateway to information; it's a dynamic search
partner that encourages active reading,
aiding you in your academic and professional
success. Designed for efficiency and
available on Windows and Mac on Chrome,

Key Software Feature List

Multi Language

it empowers users, including those with
dyslexia and other learning disabilities, to sift
through extensive text and long documents
and focus on key information. This tool
encourages active reading and enhances
understanding and engagement with written
text.

Multi Term Search

support FiﬂdM@i Change the way you search AL o @

O\ Type here to search

Saved search terms

Endoscopic

Instructions

Clouds

Programme

DNA Search Bar

LTSS | BSE

Visor
Concentration
View

FindMe - The multi term search tool. Feature Overview
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Feature List Summary

4444444

Multi-term Search

Search four terms at once. Colour code each term for clarity,
caps lock, full case word search and more. Scan long documents
with ease target research points. Participate in active reading
engage your concentration.

Colour Picker

Color-coding search terms is vital for clarity and efficiency,
especially useful when searching up to four phrases or words
simultaneously. By assigning different colours for each term it
becomes easier to distinguish in complex text, such as complex
academic or research reports. Making it easier to identify and
compare their occurrences and contexts.

Caps Only On/Off Search

Case sensitivity enhances search precision, crucial in technical
documentation, code or academic contexts where case
differences are significant. Activating this feature distinguishes
between proper nouns and common words. This level of
specificity leads to more accurate and efficient information
retrieval, thereby streamlining the research process.

Whole Word Search

Word sensitivity in web browser searches offers refined
outcomes for targeted results. Searching for partial words like
‘prove’ can yield broader results such as ‘improve’, while whole-
word-only searches focus on the exact term. This approach to
search enhances specificity and relevance in your results.

DNA Search Bar

Provides a visual representation of where terms appear on the
page, transforming how you navigate through extensive research
papers or lengthy PubMed articles. The DNA bar highlights key
terms on a built-in scrollbar, enabling users to jump to specific
terms based on their positions on the term line in the scrollbar.

Visor Focused Concentration View

Identify key terms then activate the visor for enhanced clarity.
The visor helps to identify and pinpoint the exact location of
each key search term by creating a dark overlay around it. For
additional clarity, the visor size can be adjusted to provide a more
focused or expansive view.

Multi-Lingual Search Support

Multilingual support Engaging English language learners and
non-native English speakers to quickly find the text information
they need.
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For the most up to date documentation
please see:
www.softwirededucation.com/user-manuals

Welcome to the installation guide
for FindMe. This step by step
walkthrough will assist you through
the process of adding FindMe to
your Google Chrome browser on
compatible Windows or macOS
devices.

FindMe searches websites and online
publications. Search text for a word,

a phrase, multiple words, or multiple
phrases, and Find Me will pick out and
colour-code each time they appear,
helping you to navigate the text
efficiently and effectively.

01 . Prerequisites

Before we begin the installation, please
ensure that you have:

A stable internet connection: A stable
internet connection is required for
downloading Chrome and the FindMe

extension from the Chrome Web Store.

Google Chrome: The latest up to date
version of Google Chrome installed on
your windows or mac computer. If you
do not currently have Google Chrome
installed, you can download it from the
official Chrome website:

oo @O X

FindMQ Change the way you search

()\ Type here to search

ML EE0 | BSE

Saved search terms

Instructions

Clouds

Programme

FindMe Interface

https://www.google.com/chrome

The minimum chrome compatibile version is
114.

Device Compatibility: FindMe is designed for
use on a desktop or laptop computer running
the latest version of Chrome on MacOS or
Windows. It is currently not available for the
chrome mobile browsers on smartphones or
tablets for either platform.

02. Installation Steps

Note: Your educational institute workplace provider
or disability student allowance supplier or partner
will provide you with a direct URL Link to the Google
Chrome Store to download FindMe.

Step 1: Open your Google
Chrome Browser

Launch the Chrome browser
on your computer.
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Either click on the website URL link sent to
you by your provider in your email or word
document. Or copy and paste the URL link
into your briwsers search bar and press
enter.

If your provider has only supplied you

with a serial number and this instruction

manual please click on this hyperlink to be
directed to the chrome store. The direct
download link is:

https://chromewebstore.
google.com/detail/findme/
binnelaecdennjcbflochhiedkphgicb

£ chrome web store Discover Extensions  Themes

Q FindME

Extension Education

Overview

An extension for finding and highlighting multiple words or phrases on a web page.

Q_ Search extensions and themes [ m
Add to Chrome

Step 2: FindMe Page

The FindMe Chrome Page will open.
You will be presented with a detailed
information page: including feature
reviews screenshots of the app and
an overview of its features privacy and
details.

Step 4: Install the Extension

Once on the extensions detail page, Click
the Add to Chrome button located at the
top-right of the page.

A confirmation dialog box will popup,
detailing the data and permissions the
extension will have access to.

Review the permissions, and if you agree,

FindMe Chrome WebStore Screenshot

click Add extension. If you do not agree
with the permissions, you may choose not
to install FindMe by clicking cancel.
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Vs

Themes

# chrome web store Discover  Extensions

Q FindME

Extension

Education

Q Add 'FindME"?

It can:

Overview

Read and change all your data on all websites

An extension for finding and highlighting multiple words or phrases on a web page.

~

Q_ Search extensions and themes

Step 5: Confirm Installation

+ Chrome will automatically download and
install the extension to the browser. Once
the installation is complete, a confirmation
message will pop-up to confirm.

+  The FindMe icon will appear next to the
address bar in your Chrome browser,
indicating the extension has been
downloaded and is active.

FindME has been added to X
Chrome

&

Manage your extensions by clicking Extensions in
the Window menu.

FindMe Added to Chrome Confirmation Message

Step 6: Pinning FindMe Icon to your
extension Toolbar

After installing FindMe, you may notice

rome
.

FindMe Chrome WebStore Listing Screenshot

that the extension icon appears next to

the address bar momentarily and then
disappears. After the confirmation message
disappeared. This is normal, Chrome

hides new extensions to keep the toolbar
uncluttered. To always keep the icon visible
and accessible, follow these steps to pin it to
your toolbar:

+  Locate the Extensions Icon: Look for
the puzzle piece icon on the upper right
corner of your Chrome browser. This
represents the Extensions menu.

+  Open the Extensions Menu: Click on the
puzzle piece icon to open a dropdown list
of all your installed extensions.

+  Look for FIndMe: Scroll through the list

until you find FindMe

Pin the Extension: Next to the FindMe

extension icon, you'll see a pushpin icon.

If the pushpin is outlined (not filled in), the

extension icon is currently hidden. Click

the pushpin icon to change its status.

When the pushpin icon is filled in, it

indicates that the extension is pinned to

your toolbar.
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C G Search Google or type a URL

Go

Q' Search Google or type a URL

[

Extensions

Add shortcut

[ All Bookmarks

X

Gmail Images i3}

gle

)

4

+

Add shortcut

Accessing the Extension: Once pinned,
FindMe will always be visible on your
Chrome toolbar. You can click the icon to
quickly open the app.

By pinning the extension to the Toolbar,
FindMe will always be on hand and readily
accessible, making it easier to quickly open
and use, as you browse.

03 Conclusion

Congratulations! You have successfully
installed FindMe. The multi search term tool.
Please remember to pin the icon to your
browser toolbar for quick access. You are
now set up and ready to enjoy the benefits

of FindMe. Where Discover meets efficiency.
We are confident it will enhance your
research experience and look forward to your
feedback.

For support, questions, or feedback, please
reach out to us at

support@softwirededucation.com we are
here to help.

Thank you for choosing our extension.

Pinning FindMe to the chrome toolbar for quick access

Post-Installation Steps

After installing FindMe, consider taking a few
moments to:

Customise the extension settings
according to your preferences, i.e Colour
of highlight foreground and background
this will be covered in further detail in the
user guide.

To get the most from the FindMe app,
please read the complete user guide for
the most up to date information.

Installation Troubleshooting

If you encounter any issues during the
installation process, consider these tips:

Ensure your internet is connected and the
connection is stable.

Make sure you're using the latest version
of Google Chrome.

Restart Chrome and restart your
computer/laptop and try following the
installation process again.

For further assistance, contact our support

team support@softwirededucation.com
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()\ Type here to search
For the most up to date documentation

gESTmmm|=1 5=
www.softwirededucation.com/user-manuals 7F /I\ \l/ 5|4 == —

Saved search terms

Endoscopic

Welcome to the installation guide
for FindMe. This step by step
walkthrough will assist you through
the process of adding FindMe to
your Chrome browser on compatible
Windows or macOS devices by
searching the chrome store.

Instructions

Clouds

Programme

FindMe Interface

FindMe searches websites and online https://www.google.com/chrome
publications. Search text for a word,

a phrase, multiple words, or multiple
phrases, and Find Me will pick out and
colour-code each time they appear,
helping you to navigate the text
efficiently and effectively.

*  The minimum chrome
compatibile version is 114.
+ Device Compatibility:
FindMe is designed for
use on a desktop or laptop
computer running the latest
version of Chrome on MacOS
01 . Prerequisites or Windows. It is currently not available for the
chrome mobile browsers on smartphones or
tablets for either platform.

Before we begin the installation, please

ensure that you have: 02. Installation Steps
A stable internet connection: A stable

internet connection is required for

downloading Chrome and the FindMe . . .
extension from the Chrome Web Store.  Please Follow these installation steps to install

FindMe on your Chrome browser:

Google Chrome: The latest up to date

version of Google Chrome installed on Step 1: Open the Google
your windows or mac computer. If you Chrome Web Store

do not currently have Google Chrome

installed, you can download it from the . Launch the Chrome
official Chrome website: . browser on your computer.
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+ Navigate to the Chrome Web Store by typing the URL into your browser’s address bar.

https://chromewebstore.google.com or by searching for “Chrome Web Store” in the

Google search engine.

Q, Search extensions and themes H i

£~ chrome web store

Discover Extensions Themes

Welcome to the Chrome Web Store

Supercharge your browser with extensions and themes for Chrome

EDB-@LCO

See collection

< s > »
Top categories
Shopping B Entertainment e ] Tools R Art & Design s
Recommended for you See more
J
Chrome WebStore Screenshot
Step 2: Find the Extension Step 3: Select the Extension
+ Once you have navigated to the chrome +  From the search results listed, look for
webstore, use the search bar located at ‘FindMe’
the top-left corner of the page. +  Click on the extension: A more detailed
«  Type “FindMe" into the search bar and information page including features

press Enter. reviews and images will be presented.

4 N
£~ chrome web store Q_ FindMe X : B m
Discover Extensions Themes
Type

& softwiredEducation.com @ Featured
Filter by
[ Featured extensions
[ Established publishers Settings for Chrome
@ Featured
3.3%(3)®
Ratings
\_ Get quick access to the main Chrome settings )

Chrome WebStore Search Results Screenshot
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Step 4: Install the Extension

Once on the extensions detail page, Click
the Add to Chrome button located at the
top-right of the page.

A confirmation dialog box will popup,

detailing the data and permissions the
extension will have access to.

Review the permissions, and if you agree,
click Add extension. If you do not agree
with the permissions, you may choose not
to install FindMe by clicking cancel.

£~ chrome web store

Discover Extensions Themes

Q FindMe

& softwirededucation.com @ Featured

Extension Tools 339 users

Q Add Find Me

Overview

FE) reate v @ 1

@& raae v @ @
Bl raac . @ T

~

Q, Search extensions and themes F ] m

Add to Chrome

Q.

Add extension

Step 5: Confirm Installation

Chrome will automatically download and
install the extension to the browser. Once
the installation is complete, a confirmation
message will pop-up to confirm.

The FindMe icon will appear next to the
address bar in your Chrome browser,
indicating the extension has been
downloaded and is active.

Step 6: Pinning FindMe Icon to your ex-
tension Toolbar

After installing FindMe, you may notice

that the extension icon appears next to

the address bar momentarily and then
disappears. This is normal, Chrome hides new
extensions to keep the toolbar uncluttered. To

FindMe Chrome WebStore Listing Screenshot

always keep the icon visible and accessible,
follow these steps to pin it to your toolbar:

Locate the Extensions Icon: Look for

the puzzle piece icon on the upper right
corner of your Chrome browser. This
represents the Extensions menu.

Open the Extensions Menu: Click on the
puzzle piece icon to open a dropdown list
of all your installed extensions.

Look for FIndMe: Scroll through the list
until you find FindMe

Pin the Extension: Next to the FindMe
extension icon, you'll see a pushpin icon.
If the pushpin is outlined (not filled in), the
extension icon is currently hidden. Click
the pushpin icon to change its status.
When the pushpin icon is filled in, it
indicates that the extension is pinned to
your toolbar.

Page 12 of 27



FindMe Information Manual Version 1. January 2024

Accessing the Extension: Once pinned,
FindMe will always be visible on your
Chrome toolbar. You can click the icon to
quickly open the app.

By pinning the extension to the Toolbar,
FindMe will always be on hand and readily
accessible, making it easier to quickly open
and use, as you browse.

C G Search Google or type a URL

Go

Q' Search Google or type a URL

[

Extensions

Add shortcut

. 3 All Bookmarks
Extensions

X

No access needed
These extensions don't need to see and change

Gmail Images 3%
information on this site.

Q  FindME )

8  Manage Extensions

gle

-
)

+

Add shortcut

03 Conclusion

Congratulations! You have successfully
installed FindMe. The multi search term tool.
Please remember to pin the icon to your
browser toolbar for quick access. You are
now set up and ready to enjoy the benefits

of FindMe. Where Discover meets efficiency.
We are confident it will enhance your
research experience and look forward to your
feedback.

For support, questions, or feedback, please
reach out to us at
support@softwirededucation.com we are
here to help.

Thank you for choosing our extension.
Post-Installation Steps

After installing FindMe, consider taking a few
moments to:

Pinning FindMe to the chrome toolbar for quick access

Customise the extension settings
according to your preferences, i.e Colour
of highlight foreground and background
this will be covered in further detail in the
user guide.

To get the most from the FindMe app,
please read the complete user guide for
the most up to date information.

Installation Troubleshooting

If you encounter any issues during the
installation process, consider these tips:

Ensure your internet is connected and the
connection is stable.

Make sure you're using the latest version
of Google Chrome.

Restart Chrome and restart your
computer/laptop and try following the
installation process again.

For further assistance, contact our support

team support@softwirededucation.com
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Released: January 2024 Q_ Type here to search

FindMe, Software Version 1.0 - =
GES =]
For the most up to date documentation 7F /I\ \l/ 5" ==

please see: Saved search terms
www.softwirededucation.com/user-manuals

Endoscopic

Instructions

FindMe is designed to effortless Clouds . Aa abc @, @@ T
improve research and engage users.

Encourage active reading and improve Programme . Aa abc &, @@ T
efficiency.

Targeting users with learning support FindMe Interface
from dyslexia to ADHD

Please read the FindMe user guide Step 1: Accessing the Registration Page

to setup your account and learn the
fundamentals features that will make
FindMe your research and reading
partner aiding you in your academic
and professional success.

)

Welcome to

FindMg,

Change the way you search

Before you can start using all the
powerful features of FindMe, you'll need
to create an account. Registering is
easy and only takes a few minutes when

o) @
signing up for your account please have o e
your serial number to hand. You will
need this to complete your registration ﬁ Password &

process.

If you need secondary assistance or
Forgot password?

do not know where your serial number
is please contact your educational
institute workplace provider or disability
student allowance supplier or partner.

First time user? Register now or Try for free

www.softwirededucation.com

01 Redi . d Loai + Upon clicking the FindMe extension icon for the
- Registration and Login first time, you'll be greeted with the welcome
screen. Here you will find the main option to
enter your username and password. If your
account has been setup by the Disability
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Allowance Partner (DSA) educational
institute or workplace they will provide
you with your sign in details. If this is your
first time registering, please follow these
directions:

Step 2: Creating a New Account

Click on the “Register now” link located
below the Sign In button. This will take
you to the registration page.

Step 3: Entering Your Details on the
Registration page

Fill in the required fields with your details.
This includes your name first and last and
email address. Some additional details
may include your educational institute.
Your email address, which will serve as
your username.

You will be required to enter the serial
number given to you by your DSA provider
or educational institute aot employeer as
part of the registration process.

Step 4: Completing Registration

You will be presented with links to the
terms and conditions and privacy policy
during your sign-up process, by creating
an account you agree to these terms.
Ensure you read these carefully before
agreeing.

Complete the process by clicking on a
‘Register Now' button, which is at the
bottom of the registration form.

Step 5: Account Confirmation and Error
Handling

Once you've filled in your details and
clicked the ‘Register Now' button, you
should see a confirmation message
indicating that you have successfully
registered.

You will receive a email asking to confirm
you to activate your account.

Please click on the 'confirm account'

button to activate your account.
You can now return to the FindMe login

page.

Error Handling

If there are any issues with the details
you've entered, an alert will pop up on the
registration screen. This alert will detail any
errors that need to be corrected before you
can successfully register. Common errors
may include:

Incorrect Serial Code: Make sure the serial
code provided is entered correctly, without
any typos or missing characters.

Invalid Email Address: Verify that the email
address is correct and formatted properly
(e.g., user@example.com). It's important to
use an email address you have access to, as
it will be used for account verification and
password recovery.

Password Strength: To create a strong
password, ensure that it is at least 8
characters long and includes a combination
of both lowercase and uppercase letters. It's
also advised to include numbers and special
characters for added security.

After addressing any alerts and ensuring
all information is correct, click the
‘Register’ button again to proceed.

Note: It's crucial to use an email address
that you regularly check. We may send you
important information updates periodically.
For example to notify you of updates to the
FindMe app or your account. Your email
address will also be required for account
verification links and password reset
instructions if you ever forget your password.

Step 6: First-time Login

Return to the FindMe login screen.
Enter your new credentials in the
Username and Password fields.

Click the “Sign In” button to access your
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FindMe account.
You will now be presented with FindMe
and Its main user interface.

If at any point you encounter issues with
registering or logging in, look for the ‘Forgot
password?’ link to reset your password. If you
need additional support, you can contact us
for further assistance.

support@softwirededucation.com

Note for First Time Users: If you are
evaluating the software on behalf of a
educational institute or workplace, employer
you can also opt for a free trial by clicking
on “Try for free.” This will give you temporary
access to FindMe's features, allowing you to
evaluate its capabilities fully.

Now that you're registered and logged in,
you'e all set to begin exploring the extensive
capabilities of FindMe to enhance your online
research and reading experience.
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User Guide: Navigating the
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For the most up to date documentation
please see:
www.softwirededucation.com/user-
manuals

Welcome to the "Navigating the
FindMe Interface" section of

our user guide. This has been
designed to help familiarise you
with the FindMe interface, known
for its intuitive and user-friendly
design. Our goal is to place

you, the user, at the forefront,
ensuring a seamless integration

into your daily browsing activities.

Whether you're conducting in-
depth research, perusing lengthy
articles, or simply exploring

the vast realms of the internet,
the FindMe extension is here to
enhance your experience.

This guide will break down the
user interface of FindMe, in a
simple, step-by-step approach to
explain how the extension works.
As we progress, we will highlight
and examine each section of the
FindMe interface, detailing the
icons found. We will describe
their function and the features
they unlock, and their role in
enhancing your search experience,
ensuring that you gain a thorough
understanding of how FindMe
works.

Initial User Interface

FindM©\. Change the way you search e o ®

O\ Type here to search

One Search Term Entered

Search Bar Settings Account Page

l J/ Exit Extension
FlndM©\. Change the way you search
[()\ Type here to search \l’ ]

T mEE |88

Saved search terms

Instructions

Navigation Toolbar

Visor  DNA Strip

\L Delete All Terms

Previous Term LastTerm Copy Paste Matches

TTI

7F/]\\l/>|4 =

[ 17

First Term Next Term Top Of Page

Secondary Term Toolbar

Search Term Capital Filter ~ Colour  Delete Term

! |J l]
T 11

No. of Whole Term Turn Off
Matches  Filter Terms

Instructions
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F'"dM@\ Change the way you search

Search Bar

Settings Account Page
EX|t Extension

[---c®

C)\ Type here to search

NS ]

K
O . Settings Functionality

oo o Settings Buttons
Opens a menu that allows you to

customise your search preferences and other

extension options. This includes an option

to change the highlight colour of the term

foreground and background.

How to Use

+  Click the Settings icon.

+ Select your desired options from the
settings page.

Account Page Button

This feature directs you to your
FindMe account page. Here you
can upload an image that will be saved
to your computer local browser storage
and shown on the accounts page and the
accounts icon on the main user interface
page. Your account information is also stored
Name email institution and the length of your
licence including the remaining license time.
Along with accompanying support details.

Note: On initial login your initials will display
in the account button display. This can be
changed by adding a profile picture to your
account page.

How to Use
Click the Account icon.
Here, you can update your profile, change
your password, and access account-
related settings.

Exit Extension Button
Use this button to close the
FindMe extension window.

How to Use
Click the 'X"icon.
The extension window will close, the
DNA bar will disappear and any terms
highlighted will be deslected and your
search session will end.

Note: If you click off the extension on the
webpage rather than clicking close icon the
search terms and DNA will still be visible,
ready to open the extension and carry on
searching.

02. Search Term

Search Bar

The Search Bar is where you can type in the
terms you wish to find within the current
webpage.

How to Use
Click inside the Search Bar.
Type in your search term.
Press 'Enter' to initiate the search.

Once a search term has been entered into
the search bar and you have pressed enter to
initiate the search the interface will expand to
allow the navigation bar and the term toolbar
to appear.

Note: If no search term results are found the
navigation bar will shake and no matches will
be dispalyed.
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Previous Term LastTerm Copy Paste Matches Visor DNA Strip

\L N \L \L \L \L \L Delete Al Terms
[7F/F\/>L NES [ o ]%%]
1 )

First Term Next Term Top Of Page

to the start or end of the found terms.

Click on the corresponding icon.
FindM@)\. Change the way you search SR8 0 ® P g

o\ Type here to search copy and Paste
ORISR = & &
Saved search terms + FlﬂdMe can Seal’Ch

for up to four terms,
per webpage. The
Copy button will select and copy your saved
03 L. search terms. When opening a new tab and
. Navigation ToolBar activating the FindMe extension the paste
button will automatically highlight, notifying
you there is an option available to paste your

The navigation bar is a central component of ~ Saved search terms into the current url. This
FindMe's interface, providing quick access to is especially useful when searching multiple
search functionality that allows for webpage ~ Pub med or academic articles for the same
navigation and term management. reference terms.

Instructions

—_ Previous Term and Next Term H°W to Use
/\ Arrows Highlight the term in your document.
+  Click the "Copy" button to copy the term.

Click the "Paste" button to paste a

These arrows facilitate movement , , _
previously copied term into the Search

through the occurrences of a

search term within the webpage, Bar.

allowing you to jump to the
\/ previous or next instance with LeftNumber ~ Matches
—Y— case Term Position

The matches counter
1710 indicates h
How to Use indicates how many
After performing a search, click the "Next Right Number instances of the selected

Term Count search term are found on

Term" arrow to move forward to the next
each webpage.

highlighted term.
To move back to a previous term, click the

"Previous Term" arrow. How to Use
The counter in the middle indicates your Loﬂkﬁt the counter to see the number of
matches.

current term position out of the total
occurrences found.
To move to the top of the page or to jump
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Previous Term LastTerm Copy Paste Matches Visor DNA Strip
\L \L \L \L \L \L Delete All Terms
N/
| | —— — =

[7|</]\\/>|4 M =+ :V[ 110 ]%%]

/N T
First Term Next Term Top Of Page

) DNA Search Bar
FindM@)\. Change the way you search 000 o ®

o\ Type here to search

TrLmEECe 1838

Saved search terms

Instructions

03. Navigation Tool Bar Continued

= Visor Concentration View
— The Visor creates a dark overlay
around the page, leaving only the
search terms highlighted. This
helps focus your attention on the
occurrences of the term.

How to Use
Make sure your search term is selected
and highlighted red.
Click the "Visor" icon to activate this view.
Click again to deactivate and return to the
standard view.

Extending the Visor Size

To extend the search highlight when viewing
terms with the visor enabled. Click shift

and scroll your mouse wheel upwards/
down to expand and contract the viewable
concentration focus window.

This innovative feature provides a
visual representation of where the
search terms appear on the page,
similar to markers on a scrollbar.

How to Use
After searching, notice the DNA Strip
alongside the scrollbar of your document.
Click on a marker within the DNA Strip
to jump directly to that occurrence in the
text.

Note: By default the DNA bar is turned on.

]

Delete All Terms

When you want to clear your
current search terms and start
anew, this feature removes all
entered search terms at once.

How to Use
Click the "Delete All Terms" button to
remove all active search terms.
Confirm the deletion if prompted to clear
your search slate.
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Search Term

J

Capital Filter  Colour Picker Delete Term

VIV

Instructions

TN A XSS!

FindM@\. Change the way you search

()\ Type here to search

LRSS0 | B5E

Saved search terms

Instructions

04. Term Tool Bar

Term Tool Bar Functionality

Each term you search has its own Term
Toolbar', which offers several filters and
actions designed to fine-tune the search
process. FindMe currently allows up to four
individual term searches per page.

User Note: Selecting and Navigating Search
Terms

Before diving into the specific tools within the
Term Toolbar, it's important to understand
how to activate and work with each search
term separately.

Activating a Search Term

When you want to navigate through the
occurrences of a specific search term within
your document, you must first select the term
by clicking on it in the Term Toolbar. You'll
know a term is active when it's framed by a
red outline. This visual cue indicates that the
Navigation Bar is now linked to your chosen
term.

T 71

No. of Whole Term Turn Off
Matches  Filter Terms

Using the Navigation Bar

With the term selected, you can use the
Navigation Bar to jump to the next or previous
instance of that term in your document. The
Navigation Bar's controls will only affect

the highlighted term, allowing for focused
reviewing of your search results.

Switching Between Saved Searched Terms
To navigate occurrences of a different

term, simply click on the new term in the
Term Toolbar. The red outline will shift to

the newly selected term, and you can then
use the Navigation Bar to move through its
occurrences. If you wish to search for a new
term, type it into the search field and it will be
added to your Term Toolbar for navigation up
to a maximum of four terms.

Instructions

Example Selected Search Term Highlighted Red

Search Term: The search term is displayed
on the left hand side of the term toolbar.
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s

winter's icy grasp in many regions.

01 JANUARY 2024 by SoftwiredEducation *

FindM@< Change the way you search 89 ® ®
C)\ Type here to search
TALLES e | aEE

Saved search terms for this page

Snow

When will the SROW fall in winter

In January, many parts of the world experience a characteristic winter chill.
Winter's days are short, and nights grow longer as the month progresses.
BfiBWirall and frost often transform landscapes into a serene, wintry
wonderland. People bundle up in warm coats, scarves, and gloves to brave
the cold temperatures and BH@W. Overall, this month marks the embrace of

Figure 1 Search Overview
J

The term toolbar colour
will be the same colour as the terms found
on the webpage, in this case the terms will be
highlighted blue.

Number of Matches:
The term bar displays a
secondary count of how
many term instances
are found. Important for
multiple term searches.
Where the navigation bar
only displays the number of terms on the
currently selected highlighted term.

Capital On/Off Search Filter
Case sensitivity enhances
] search precision, crucial in
technical documentation,
code or academic contexts
where case differences are
significant. Activating this
feature distinguishes between proper nouns
and common words. This level of specificity
leads to more accurate and efficient
information retrieval, thereby streamlining the
research process.

A

(@b

How to Use

+  Click the ‘Aa" icon to activate case
sensitivity. When active, only terms
with the exact case as typed will be
highlighted.

+  Click again to deactivate case sensitivity,

which will highlight terms regardless of
capitalisation.

When will the snow fall in winter

In January, many parts of the world experience a characteristic winter chill.
Winter's days are short, and nights grow longer as the month progresses.
BB (all and frost often transform landscapes into a serene, wintry
wonderland. People bundle up in warm coats, scarves, and gloves to brave
the cold temperatures and snow. Overall, this month marks the embrace of
winter's icy grasp in many regions.

01 JANUARY 2024 by SoftwiredEducation «

Figure 2 Capital Search )

When capitalisation is turned on the number
of matches highlighted drop from three in
figure 1 to one in figure 2.

Word sensitivity: Searching
for partial words like ‘prove’
can yield broader results
such as ‘improve’, while
whole-word-only searches
focus on the exact term.
This approach to search
enhances specificity and relevance in your
results.

b

C)

(O

o
o
o
o
5
.
.

How to Use
+ Toggle case sensitivity for the search
term.

«  The search will refresh to highlight only
the whole instances of the term.
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Ve

When will the ShoW fall in winter

In January, many parts of the world experience a characteristic winter chill.
Winter's days are short, and nights grow longer as the month progresses.
Snowfall and frost often transform landscapes into a serene, wintry
wonderland. People bundle up in warm coats, scarves, and gloves to brave
the cold temperatures and BfiBW. Overall, this month marks the embrace of
winter's icy grasp in many regions.

01 JANUARY 2024 by SoftwiredEducation «

Figure 3 Whole word term search )

Snowfall has been filtered out of the search
terms in Figure 3. The number of search
terms found in total has been updated. To
reflect the new number of terms found,
which is two in this example.

Colour Picker green.
When searching up to
A four phrases or words How to Use

simultaneously. Varying

the colours for each term
can makes it easier to
identify and compare their
occurrences and contexts. Figure four shows
the highlight colour changing from blue to

Click the colour picker icon.

Select a colour from the palette that
appears. The term's tab bar and the
document highlighted search instances
will automatically update.

e N N
F'nnd@\. Change the way you search oo ® ®
C)\ Type here to search
— .. =
ORI BEVEN =] > £] |
Saved search terms for this page
When will the Bia0 fall in winter
In January, many parts of the world experience a characteristic winter chill. ]
Winter's days are short, and nights grow longer as the month progresses. 4 . b O
i rall and frost often transform landscapes into a serene, wintry 51 133 1
wonderland. People bundle up in warm coats, scarves, and gloves to brave
the cold temperatures and [l Overall, this month marks the embrace of R G B
winter's icy grasp in many regions.
Figure 4 Colour Picker
01 JANUARY 2024 by SoftwiredEducation =
\ J
Term Off Delete Term
This feature temporarily ol Use this to remove the
D disables the term from J ] search term highlighted
the current search without J from the current session
deleting it, allowing for completely.
focused searching on other
terms.
How to Use How to Use

-+ Click the 'toggle' icon/button to toggle
the visibility of the term’s highlights in the
document from on to off.

-+ Click again to reactivate the term in the
search.

Click the trash bin icon to delete the term.
Confirm the deletion if prompted, and the
term will be removed from the search and
the Term Toolbar.

Page 23 of 27



Advanced user Settings

Released: January 2024
FindMe, Software Version 1.0

For the most up to date documentation
please see:
www.softwirededucation.com/user-manuals

Managing Your Profile

The account page accessed via the
accounts button at the top right of the
user interface on the main page, holds
your personal information.

Profile pictures currently is set
automatically to display your initials.
In upcoming releases you will be able
to upload a profile picture. Profile
pictures will be visible in the accounts

page and in the main interface page.
If you need assistance there is a

support email address that you can
contact if you have a list of questions.

01 « Account Page

FindMe account page. Your account
information is stored your name email
institution and the length of your licence
including the remaining license time.
Along with accompanying support
details.

Note: On initial login your initials will
display in the account button display.
This can be changed by adding a profile
picture to your account page.

Fi I"IdM Change the way you search

...o@

-ducation

info@saoftwirededucation.com

wing 4 terms.

< Back Account Information
Name Softwired E
Email
Institute
License 3 Year allo
Expires In over a year.

| R \| |’ ol | support@softwirededucation.com

F

indMe Account Interface
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Support and Resources

Released: January 2024
FindMe, Software Version 1.0

For the most up to date documentation
please see:
www.softwirededucation.com/user-manuals

Frequently Asked Questions (FAQs)

Welcome to the FAQ section of the
FindMe user guide. To check for the
most recent version of the FAQ please
see

www.softwirededucation.com/faq

This section is designed to provide
you with information and insights on
how FIndMe works and how we look
after our users information. We've
compiled a list of the most frequently
asked questions to help you resolve
common issues and questions.

If your question isn't addressed here,
remember that our Customer Support
team is always ready to assist you
with any further inquiries.

01 . Information

What information are we storing?

We store your full name and email
address and institution which we use
for registration and sending an email
confirming your registration. The
password you set is only know to you.
We may email you tips and suggestions
or to inform you of product updates.

FindMQ Change the way you search SASas 0 ®

()\ Type here to search

TSSO | BSE

Saved search terms

Endoscopic

Instructions

Clouds

Programme

FindMe Account Interface

Do you track the searches | make?

The search terms you make against a web page
are never stored on our servers and nor is the
URL you are searching, the search is made client
side and your previous searches are stored in the
browser, accessible only to the FindME extension.

Can | search for anything?

There are no restrictions to the terms you can enter
or the pages you can search on.

Are there any pages FindMe doesn't work on or
search?

We have done our best to test FindME but the
internet is a big place, we may have missed some
of it! Pages that have html text areas are slightly
problematic, although the latest release now
addresses these issues. If you are highlight any
issues, please use our contact page to address any
issues.

It will not search googles own account page or
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setting pages - a block put in place by google.

Can | be assured the searches | make are
accurate?

We have tested the extension extensively,
however, due to the nature of web page
design there may be instances where the
extension shows it has found more terms
than you can see, or misses terms that you
are sure are present.

If you have any issues please email us at

support@softwirededucation.com

Where possible please provide examples with
screenshots and URL addresses we will do
our best to address them.

Does FindMe work in different languages?

We have tested FindME against as many
languages as we can and believe it will
search effectively against text in most, if

not all, languages commonly displayed on
the internet. We have also built in a system
for Latin character based languages that

use diacritics, to allow you to enter a term
without any accents and still find those
words in their language specific form. For
example searching for hotel will also highlight
instances of hotel, searching for inaltime will
highlight instances of inaltime. You shouldn’t
need to know the language inside out to be
able to search for terms in it, nor should you
need to know how to construct the accents
on your keyboard just to do a search, however,
if you do we support that as well and as a
shortcut you can highlight a term on a page
and search for it directly from the popup right
click menu. We think we've got your search
needs covered!

Can you search Online PDF Files?
Our initial release version 1.0 will not search

PDF documents displayed through Chrome,
however, once we have conducted our testing

on the module that is in development we will
be releasing a fully PDF aware update.

Can | search an image for text?

Currently not, we have tested some OCR
techniques that definitely work but we are
not sufficiently happy with their speed and
requirements they place on your computer to
be happy to release that feature just yet.

02. Customer Support

Should you require personalised assistance,
our customer support team is ready to help
you with any queries or issues that aren't
covered in the FAQs or software manual.

Every piece of feedback is an opportunity for
us to grow and refine FindMe.

Reporting Issues and Asking Questions

If you encounter any issues or have questions
about how FindMe works, we want to hear
from you. Please do not hesitate to reach out
with:

Technical problems you are experiencing.
Questions about functionalities or
features.

Usability concerns or difficulties in
navigating the extension.

Suggestions for Improvements and New
Features

Please provide screenshots of the errors
with details of the version of google
chrome you are using as well as the
URL and search term. So we can try and
recreate the error.

Have an idea that can make FindMe even
better?

Whether it's a small tweak or a big idea for a
new feature, your suggestions are welcome.
Share your thoughts on:
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Improvements to existing features.
New functionalities you would like to see.
Overall user experience enhancements.

Your insights are invaluable in helping us
shape the future of FindMe. Together, we can
ensure that the extension not only meets but
exceeds your expectations.

Contact:

support@softwiredEducation.com

www.softwirededucation.com

02. Conclusion

We hope this guide has equipped you with
the knowledge to use FindMe effectively.
Remember, our team is here to support your
journey, and we welcome your input to make
FindMe even better. Explore, experiment, and
excel with FindMe.
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